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Officers re-elected
The current officers were re-elected by
acclimation at the June meeting. President
Rick Curry’s two-year had not expired, so he
was not up for election.
Vice President Craig Ladd, Secretary
Diane Mortensen and Treasurer Art Lewis
were re-elected.
The immediate past president, Paul Westefer, is also an officer. The other board members are appointed positions.

Inside
Photographer shares tips and tricks
— Page 9
Attendees report on computer conference
— Page 11
Open source program to create PDFs
— Page 15

By Rick Curry, President

H

appy Independence Day! Mandatory history fun facts: We declared Independence on July 2 (to the arriving British Navy); July
4 was the day Congress settled on the text of the Declaration of
Independence. July 8 was when the Declaration was first read to
the public. The actual fireworks began a week later at Lyndley’s Fort, S.C. It
was about 2½ weeks later (Aug 2) that the famous signatures began to appear
on the documents.
Thanks to Dan Holmes for his Tips & Tricks for digital
photography. I think the most interesting parts of his talk were
on composition and not specific to digital media. Dan is a local
Ventura businessman and can be found on the Web at http://
danholmesphoto.com
Sit Up Straight!
Curry
The importance of my mother’s cheerful reminders about
posture was recently emphasized to me by a chiropractor. It is
not just about appearance — who knew?
What the chiropractor showed me was how the spine should look like a
cobra standing up for a strike: a curve at the base near the waist and a curve
at the top by the head. Then he showed me what I was doing. Then I went
back to work and could easily see half of the people doing the same thing!
I, and apparently a lot of other people, crane my neck toward the screen
when I get engrossed in a problem. In some apparent attempt to gain enlightenment through proximity to the radiance of the pixels, I arch forward seeming poised to literally dive into the problem.
This somewhat comical and mostly harmless histrionic becomes an issue
when the position is sustained. Aside from the unflattering turtle appearance I
give myself when I do this, it pulls on the muscles in the neck and shoulders
and gives me an ache between my shoulder blades.
And this was my epiphany for the month: Proper posture at a computer
means sitting like a concert pianist (hint: Your back should not be against the
back of the chair if your hands are on the keyboard!), and your head should
be back (I am still having to work on this one).
And of course, if you are feeling a need to slouch, you probably need to
get up and walk around or perhaps to take a short nap. It is surprisingly diffi(Continued on page 3)
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Coming events

Infogrip presentation scheduled in July
Programs
Aaron Gaston of Infogrip Inc. inVentura will be the speaker at the July 24
meeting at the Camarillo Boys & Girls
Club, 1500 Temple Ave. (southeast corner of Ponderosa Drive and Temple Avenue), Camarillo (see map on page 20).
Infogrip, 1899 E. Main St., Ventura,
offers a variety of assistive technology
hardware and software in several categories: keyboards; pointing, mice, trackballs; software; ergonomics; switches;
vision; communication; mounting; adapters; desks/workstations; and miscellaneous. The company’s website is infogrip.com.
The doors open at 8:30 a.m.. The
Internet and Networking SIG and the

Computing 101 SIG start at 8:45 a.m. If
you can show up early to help set up,
please do. The room seems to be different
every month, and we have to move lots of
tables and chairs around.
Other coming meetings:
Aug. 28: Tentatively, a presentation
by Toby Scott and Michael Shalkey.
Sept. 25: Iolo — Michael Simpson
and/or Abbas will discuss Search & Recover and Drive Scrubber.
Oct. 23: Klassic Specialities, Don
Baker (ink, paper and other printing
needs).
Nov. 20, Third Saturday: Jim Glass,
Ins & Outs of Digital Photography.
Dec. 18, Third Saturday: Toby Scott
and Michael Shalkey on a topic to be

announced.
SIGs
Except for the Thousand Oaks PC
Club Photo Group, the Special Interest
Groups (SIGs) are sponsored by CIPCUG
and led by volunteer club members.
Unless otherwise noted, the CIPCUG
SIGs run from 6:30 to 8:30 p.m. at
Ventura County Computers, 2175
Goodyear Ave., Unit 117, Ventura; phone
289-3960. From the 101 Freeway, exit at
Telephone, take Telephone south to
McGrath, turn left and go one block. Turn
right on Goodyear and right again into the
second driveway. Unit 117 is the back,
right corner of the building.
(Continued on page 4)

Minutes of June Board of Directors meeting
By Diane Mortensen
secretary @cipcug.org
The CIPCUG Board of Directors held
its monthly meeting on
June 26, 2010. In attendance were President Rick
Curry, Immediate Past
President Paul Westefer,
Vice-President Craig Ladd,
TOE Editor John Weigle,
Tech Adviser Toby Scott, Mortensen
Treasurer Art Lewis, Helen
Long, Membership Chairman Ken
Church, and Secretary Diane Mortensen.
The meeting was called to order by
Rick, who asked if there was any old
business and/or updates:
Diane provided the board with a
breakdown of expenses for the Southwest
Computer Conference she and Craig

More on Command.com
(Continued from page 1)

cult to absorb new ideas without a nap;
our brains need a chance to file the information away.
Now remember what your mother
told you and sit up straight!
Happy computing!

attended June 4-6, 2010. All expenses
were covered with $4.25 remaining,
which was given to Art. Craig and Diane
summarized their experiences at the
Southwest Computer Conference.
Ken notified the board that today’s
meeting and SIGs were recorded with the
new digital recording equipment and that
Diane would receive the USB flash drive
containing today’s regular Q&A session
recording and the transcription software
will be loaded on Diane’s computer.
Diane will keep the transcription kit containing the footswitch, software disk and
headset. A backup cassette tape was also
made of today’s meeting including the
Q&A session and given to Diane, just in
case.
Turning to new business:
Craig provided the board with a tally
of the meeting surveys collected from
CIPCUG attendees at the April meeting
and published in the May issue of TOE.
There were only 12 returned surveys.
The majority of the respondents were
satisfied with the club’s meeting presentations and some would like to see more
diversity in door prizes and SIGS.
Paul commented that there were only
three people at the Beginner’s Sig today.

Discussions ensued on how to promote
this SIG to a broader population.
John announced that the cutoff date
for TOE articles is Sunday, July 4, 2010.
Helen volunteered to update CIPCUG’s website to the degree she is able
and has time.
The subject of future meeting presentations was discussed, and Toby again
offered, if requested in advance, that he
and Michael could develop a range of
topics to present. Toby suggested one or
more could be on free open source programs or “freeware.” Of interest is more
information and “how-to” for Office 2010
and the numerous free programs available, including OpenOffice. Along this
line, members discussed when Toby and
Michael make the next presentation on
freeware, that a variety of freeware programs be loaded on to new flash drives
and available for sale.
Art presented the treasurer’s report for
May 2010 to board members in addition
to presenting it in today’s business meeting. A copy of the treasurer’s report appears elsewhere in TOE.
With no further matters to discuss, it
was moved, seconded, and approved to
adjourn the meeting.
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Q&A

NoScript Firefox add-on, Java Script
Unless otherwise noted, the questions
are answered by Toby Scott, our
technical adviser and a partner in
Ventura County Computers. — Editor
Internet and networking SIG
Reported by John Weigle
NoScript Add-on
Q: Last time, you discussed an add-on
to Firefox that stopped something from
playing. Can you go over that again?
A: You’re probably talking about NoScript, which allows Flash, JavaScript,
Java and other executable content to run
only from trusted domains. You can allow scripts to run on sites you trust.
Michael Shalkey: When you have it
installed, you’ll get a notice of scripts that

it blocks, and you can decide whether to
let them run or not. He went to CNN.com
with NoScript running and showed both
the notification and blank spots on the
screen where the script items would normally appear.
Toby Scott: Most of these items are
ads. The sites get paid if you click the
link to an ad. The most common one is
DoubleClick.com. If you look at the
cookies on your browser, you’ll find
some that track the DoubleClick ads you
go to.
Michael Shalkey: NoScript puts an
icon in the lower right of your browser
when it’s running. Clicking on it brings
up several options.
Toby Scott: Firefox can be modified
in many ways. Companies and individu-

als write add-ons for it, including some
for FTP, news readers and various social
networking sites. When I tell you it’s
customizable, I’m not kidding, but don’t
load it up because that will slow its opening. If you find Add-ons you don’t like,
delete them rather than just letting them
run.
JavaScript
Q: What’s JavaScript?
A: It’s like a batch file, a series of
commands to run. It’s an unfortunate
name because it’s not related to Java.
JavaScript gets browsers to do things,
some of which you don’t want done. It’s
a constant war between script writers and
script blockers to prevent the bad things.
(Continued on page 5)

More on coming events ...
(Continued from page 3)

The pre-meeting SIGs are at 8:45 a.m.
at the Boys & Girls Club. The aftermeeting SIG is at 1:30 p.m. at The Star,
550 Camarillo Center Drive, Camarillo.
There is no charge for members to
attend the CIPCUG SIGs.
Until further notice, the Photo
Group is not accepting new members
or guests because it is close to
outgrowing its meeting room. The
TOPCC Photo Group, which meets at
6:30 p.m. at the Thousand Oaks Library,
1401 E. Janss Road, charges $3 per
meeting for those who are not members
of the Thousand Oaks PC Club. The Web
site is http://topcc.org/dnn/SIGsPrograms/
PhotoGroup/tabid/65/Default.aspx.
The general schedule
First Monday (except in months that
have holidays on or near the first
Monday): TOPCC Photo Group. It is not
taking new members or guests until
further notice.
Fourth Tuesday: Linux.
Fourth Saturday (or the regular
meeting day): Computing 101 SIG
(Jessica Scott and Mark Maidel) and
Internet and e-mail SIG, 8:45 a.m.
Michael Shalkey’s after-meeting SIG at

Door prizes

The club gets 10 percent of the sales
price. Sold items must be picked up at
the end of the day’s meeting. Any items
not picked up will become the property of
CIPCUG and will be subject to disposal
at the club’s discretion.
CIPCUG is not responsible in any
way for items bought or sold at the table.
Each item is sold as-is unless otherwise
stated.

We have two types of raffle tickets:
one for prizes offered by the presenter
and one for club-provided prizes. The
tickets for the presenter’s prizes are free
and limited to one per member.
The tickets for the club-provided
prizes are $1 each, $5 for six tickets, $10
for 13 tickets, $15 for 20 tickets and $20
for 27 tickets and are available to
anyone. Those who can’t stay until the Meeting, SIG notices
drawing may sign their tickets and give
If you would like e-mail notices of
the person selling the tickets a list of the
prizes they would like in the order they’d regular meetings and SIGs, go to
pick them. Winners’ prizes will be held www.cipcug.org, where you’ll find a link
on the home page to sign up. The URL is
until the next meeting.
cipcug.org/listserv.cfm.
Consignment table
You will need your membership
A consignment table is set up at every number, which is on the back cover of
meeting. Anyone can buy, but only TOE, to complete the sign-up.
members can sell.

The Star, 550 Camarillo Center Drive,
Camarillo.
The schedules for the balance of July
and all of August follow:
July
Saturday, July 24: regular meeting
and SIGs, program is Infogrip.
Tuesday, July 27: Linux SIG. Question-and-answer session.

August
Tuesday, Aug. 24: Linxu SIG. Topic
TBA.
Aug. 28: regular meeting and sigs,
program TBA.
Be sure to check the calendar on
cipcug.org for updates on event programs, dates and times.
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More Q&A: Eudora, Linux viruses
(Continued from page 4)

If you don’t do updates to your browser,
it’s vulnerable to attacks.
Acrobat Reader; Windows 7 boot disk
A question on blocking scripts in Acrobat Reader was delayed to the general
Q&A.
A question on preparing a boot disc
for Windows 7 was delayed to the general
Q&A.
Eudora
Q: Is there a new version of Eudora?
A: Not really. Qualcomm stopped
making the e-mail program because there
were so many free e-mail programs they
couldn’t make any money from it.
Mozilla is working on a new version, but
so far the only versions are beta, which I
don’t recommend. The older Qualcomm
versions don’t work very well any more.
(Those who want to follow the development of Mozilla’s Eudora and go to
https://wiki.mozilla.org/
Eudora_Releases.)
The Mozilla Foundation is good about
not releasing things too soon, unlike some
of its competitors.
Linux viruses
Q: Can Linux get a virus?
A: Yes. At a white hat hacker conference recently, Macintosh was the least
safe architecture. But it’s not attacked
because of its small market share. This
year, a hacker got into a Linux box faster
than Windows 7.
Windows 7 and Vista are architecturally safer than Mac and Linux, but more
people use Windows machines, so they’re
attacked more. The sophistication of most
Windows users is also less. Windows has
about 90 percent of the market and Mac
about 5 percent, with other systems making up the rest. More information about
market shares of a variety of software,
including operating systems and browsers, can be found at http://
marketshare.hitslink.com.
Windows has a reputation of being
more insecure because more hackers try
to get into it, and Windows machines are
easier to find when hackers search the
Internet for insecure computers.
E-mail problems
Q: Thunderbird doesn’t send copies of

Playing games online
This month’s Q&A topics:
Office emulation
Internet and e-networking SIG
No upgrade price for Office 2010
NoScript Add-on
Reading 2010 documents in 2003
JavaScript
Scanning document to fill in
Acrobat Reader; Windows 7 boot
blanks
disk
Finding a missing menu
Eudora
Making Windows 7 boot disks
Linux viruses
Finding cheaper Office 2010
E-mail problems
Recovering from disks
Restrictions on new drive
Regular Q&A
Free Microsoft Office
my replies to Hotmail messages back to
Hotmail.
A: If you answer the mail from Thunderbird, Thunderbird keeps a copy of the
sent mail on your computer. That’s true
of any e-mail client. If you answer the
message from Hotmail, a copy of the
message will be saved in the Hotmail sent
box. If you want a copy of the answer on
Hotmail, you can work around it by sending a blind carbon copy (Bcc) to yourself
at your Hotmail address and then move it
to your sent messages folder.
If you want to sync your e-mail on
different machines you can use this technique, but do it judiciously. Open Thunderbird, go to Tools > Account Settings
and open an account. Go to Server Settings and check the box “Leave messages
on server” and pick a comparatively short
time period. This will let you download
mail to one computer, leaving the messages on the server. Then sign on with the
other computer and download the messages. Be sure to delete messages after
you’ve downloaded to both computers or
your ISP is likely to get quite unhappy
with you.
Q: Does it work with accounts on the
Internet? Live Mail can bring in mail
from other accounts. Sometimes if I delete items in Gmail, Live Mail picks them
up again.
Audience: Gmail says it can pick up
messages from lots of other online programs.
Michael Shalkey: Check or uncheck
the “Leave on server” box for each account you have to change the option.
Q: Gmail sometimes doesn’t appear in
Sent mail.

A: That shouldn’t happen. I don’t
have a solution.
Q: I’ve sent mail that didn’t arrive,
and people have sent me mail that didn’t
arrive. I have accounts on Yahoo and
Hotmail.
A: Both programs have anti-spam
tools. Hotmail puts what it believes to be
spam in a suspected junk mail folder.
Yahoo is more destructive and just eliminates some messages it thinks are spam
and doesn’t give you a chance to decide. I
find that unacceptable.
I check my Yahoo account every three
months because I have it listed as an Outlook task so they won’t disable the account. I use it only for testing if a customer calls and says his client with a Yahoo account isn’t getting a message. If it
goes to my account, I know the problem
is with the client’s account. I just delete
everything when I go to it. You need a
Yahoo account if you’re an e-mail administrator. I don’t approve of any e-mail
administrator playing God and deciding
what messages will be eliminated without
the intended recipient’s knowledge. I
have no problems with suspected spam
being sent to a junk or spam folder that
you can check.
If you decide to switch e-mail accounts, you’ll have to notify everyone
you want to get mail from. One way to do
that is to send them a message from the
new address noting you have a new address and when they reply it’ll go in their
address book.
Michael Shalkey: Hotmail and some
other programs have a “not junk” button
on messages.
(Continued on page 6)
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More Q&A: Office versions, online games
(Continued from page 5)

Toby Scott: I like Gmail and Hotmail
but not Yahoo. Yahoo is fine if you get
little mail. But if a message doesn’t show
up in the inbox or junk, you’ll never see
it.
Michael Shalkey: To be fair, they’re
fighting spam, but it’s incredibly aggressive.
Toby Scott: My wife is an architect,
and Yahoo won’t accept her big files or
send any kind of error message or indication that the mail was not accepted. It’s a
problem when clients say they didn’t get
a message, and she says she sent it.
Q: Thunderbird is getting duplicates
of messages. I’ve unchecked “leave on
server.”
A: I don’t know for certain. The only
thing I can think of is that it’s not completing the download and starts over. After the server sends the last message, it
sends a message to the e-mail program
saying, “that’s all; did you get everything?” If your computer says yes, the
server deletes the messages; if your computer says no, the process starts over, and
you might get duplicates there. The process is called “ack exchange” (for
“acknowledgement exchange”).
Michael Shalkey: MozillaZine at
http://kb.mozillazine.org/
Duplicate_messages_received has some
possible solutions, but use them only if
you’re getting duplicate messages. The
possible solutions (taken directly from the
Web site):
“Set Thunderbird to delete messages
from the server: go to ‘Tools > Account
Settings > Server settings’, and uncheck
‘Leave messages on server.’
“Compact your mail folders on a
regular basis.
“Compact folders, exit Thunderbird,
and go to your mail folders (in your profile folder). Delete the index files, named
‘*.msf’ (such as ‘Inbox.msf’). These will
be rebuilt when you launch the application again. (You should not need to do
this on a regular basis, however.)
“Try deleting the popstate.dat file
from the account subfolder in the ‘Mail’
folder in your profile folder. If
‘popstate.dat’ gets corrupted Thunderbird

can get confused about what has been
downloaded. (Note: if you delete
‘popstate.dat’ and you still have messages
on the server that have already been
downloaded once, they will all get
downloaded again.)
“As a last resort, you can try creating
a new profile, setting up your accounts in
it, and then migrating your mail and address books over from the old profile.
“If you share your mails with Windows/linux viaThunderbird (prefs.js tip),
and you always get the leaved message
again, ensure you’ve removed all the relative paths in the prefs.js you’ve modified.
“Of course, if you try deleting files or
making a new profile, it’s wise to first
make a temporary backup of your mail
and settings.”
Regular Q&A
Reported by Diane Mortensen
Free Microsoft Office
Q: Which of the Microsoft Office
2010 editions is free?
A: A starter edition will be free, and
they are about to announce that; however
the starter edition is just Word and Excel.
Playing games online
Q: Does anyone in the group have any
suggestions on how I can play games
with my 9-year-old grandson who lives in
Indiana? Could that possibly be done by
using Skype or is there a way that I being
here and he being there can install a program so that we might be able to play
together?
A: In Windows 7, you can go to the
games and there is Internet. Microsoft
came up with Internet Checkers, Internet
Hearts, Spades, and several games that
are Wild Tangent. I do not like WildTangent games because of spyware, but there
are several of these gaming things. What
you can do is use Skype or a chat window
and sign into like Game 435 when there is
an empty seat. Kids can do card games or
whatever kind of game you are in. You
can pick your opponent.
Q: So, is there like one table in front
where each one of us can move in, and it
shows up on both? With Skype, can we
also talk back and forth? In addition, is

this available for those who do not yet
have Windows 7?
A: Correct. You would use Skype for
your chat, play the games, and include
voice. You can go on with XP. There are
many online games, but stay with major
links. Microsoft has a lot of online games
and Sierra, too. I do not know that much
about gaming.
Audience comment: Most kids have a
Wii and you can hook up the Internet to
the Wii and play games that way.
Office emulation
Q: In Office 2007, there is a getting
started selection you can hit on, go back
and it will bring up an emulation of 2003
if you can’t find your commands in 2007.
There is also a lone custom toolbar across
the screen you can populate with your
personal commands. It is terrible, but at
least it is there. My question is can you
purchase Office 2003?
A: Possibly on eBay, but not from
major vendors so you may not feel too
comfortable.
No upgrade price for Office 2010
Q: I like to have everything that is
new, but I am resistant going to 2010
because they do not offer an update. You
have to get the full version.
A: Yes, there are no upgrades to 2010.
Understand Microsoft-think and increasingly Microsoft money is made from corporate sales and not from people like us.
What they are trying to get people to do is
to essentially license a product on an annual fee and you can get Office with the
software assurance and it gives you a
certain amount of tech support and anytime a new product or conversion comes
out you get a license for it automatically.
That is what they want to sell, the product
with software assurance. In order to encourage that, they got rid of the upgrade
rates. It’s a corporate decision, not much
you can do about it. Understand you can
use Office ’97. I did it.
Reading 2010 documents in 2003
Q: Those of us with 2003, can we
read 2010 documents? Do we use the
same translator used for 2007?
A: Yes, same format as 2007. They
(Continued on page 7)
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More Q&A: PDF documents, boot disks
(Continued from page 6)

changed the format between ’97 and 2000
and then it was the same format to 2000,
2002, 2003, and they changed it for 2007
and it is the same as 2010. There are
three formats — ’97 format, 2000 to 2003
formats and then 2007 to 2010 so far formats.
Scanning document to fill in blanks
Q: Can you scan a document in 2010,
then go in, and fill in the blanks. In Open
Office, you can, in Microsoft Office, no.
Michael: I had this as the topic as one
of the after-meeting SIGs three months
ago. I can rerun that SIG and show you
how to turn any piece of paper into a syllable, audible PDF. I can do that as a tutorial to show you that; it is easy to do.
Q: Is it something you can write up in
TOE?
A: It is a little complicated, and there
are many pictures and would take up too
many pages in the TOE. It is hard to explain in words and you have to understand how to do it by seeing it. I could do
a PowerPoint presentation and put it up
on the CIPCUG website. Another SIG I
would like to work on is how to record
your screen as a movie and then save that
image as a file. I could do a tutorial that
way. I can do the whole thing and then
save the tutorial of the video of how it
looks, then save it as a file. That is something I want to work on in the next several months. I am running out of topics
for my SIGs.
Finding a missing menu
Toby: In Internet Explorer and in almost all of the new Office things and the
default settings for Windows, you will
notice that the menu bar — File, Options,
Edit, View, Tools, etc. does not exist. If
you hit the ALT key, it will pop up. Anytime you are in a program that you expect
to see that and you do not see it, hit the
ALT key, which is right next to the space
bar. It is a pop up to the menu so you do
not lose your space. I do not know anyway to pin it back up. Get used to it, because it is here to stay.
We are going to revisit the security
settings for Acrobat. In news broadcasts
about Internet security, it is stated that

sometime this year, Adobe will beat Microsoft as the most vulnerable part of
your computer where bad people can
come in and take over. They are going to
win.
Here is one of the ways to prevent it.
Open up Acrobat Reader (any version
from 6 to 9) go to Edit > Preferences, and
click on Javascript then definitely UNCHECK that box where it says, “Enable”
which should be left blank. That means
that when I open up a PDF file such as an
attachment to an e-mail, it can have embedded in it a Java script, which could be
malicious and can take over my computer. If I just look at a PDF, my computer can now be infected. Also note at
the bottom where it is says trust manager
and states “allow opening of non-PDF file
attachment with external applications.”
Think about what that sentence means: I
want a PDF I am opening to actually open
up some other program on my computer
and do something else without my knowledge or permission. The concept of that
sentence is stupid, and, by default, Adobe
checks it. Make sure the box is left blank.
Audience Comment: I work at AT&T
and we have several patches of Acrobat 9
at work, and at home, I have Acrobat Pro.
I receive updates from Adobe all the time
and when installing, I lose my security
updates. Apparently, they are aware they
are vulnerable.
Michael: Adobe announced that they
are going to do security patches once
every three months. Everyone in the security field laughed. They have been doing
it once every month, and now they may
go to doing it once every two weeks because they are finding so many to fix.
Making Windows 7 boot disks
Q: How do you make boot disks for
Windows 7?
A: Disks for repair: Start, type repair,
take the first option, put your disks in,
and go create repair disk. The CD is only
a repair disk; it does not re-install Windows; it only repairs your existing installation. It will boot only the computer you
are sitting at. This is crucial to do if you
want to be someone, like me, who helps
other people. There are two types of repairs for the two versions of Windows —

32-bit and 64-bit repair disks. You want
to make sure you are using the right repair disk if you are trying to repair a computer. When I do it on the computer I am
working at and it is a 64-bit, then I will
create a Windows 7 Home Premium 64bit repair disk. This will boot only the
machine I am at and repair any problems
I am having. That is why everyone should
burn his or her own boot disk.
You can also do a restore disk. Once
everything you want is installed and
working correctly, in Windows 7 click
Start and type “backup” and then select
Backup and Restore from the options
presented. On the left, select “Create a
system image.” If you have a new computer, it will take three DVDs; the more
stuff you have on it, the more DVDs it
will take. Once you get your computer set
up and have all of the updates done and
everything like anti-virus programs, etc.,
you burn it on to DVDs. Then if your
hard drive ever dies, you have your own
restore DVDs to put in a new hard drive
for your computer. It will completely
rebuild your computer to the state it was
when you created the disks.
This is a much better method of restoring especially if you bought a Dell or
HP and they gave you system restore
disks. By the time you do it, hopefully,
you have already gotten rid of the junkware that HP put on and you are creating
an image without the junk. If you use the
restore disks, you were given by the
manufacturer, all the junk will come back
like McAfee Security Suite 30-day trial
and all the other things you do not need.
Another thing is that with some of the
vendors, if you lose your restore disk(s)
you are out of luck. If you burn them, you
can save them yourself.
The boot disk boots an operating system on to the CD and you can make improvements and change things in your
Windows system. You can use the boot
disk when the hard drive is working, but
if something happens, it will not boot
correctly. It will not erase the data, and
there is an option to restore this image,
what we just spoke about, and if you
want, one of the options on the repair disk
(Continued on page 8)
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Program: Digital photography tips and tricks

Ventura photographer shares some secrets
By John Weigle
jweigle@vcnet.com
Photographer Dan Holmes of Ventura
summed up his presentation on tips and
tricks for digital photography this way:
Tip No. 1: Learn the fundamentals.
Tip No. 2: Get it right in the camera.
Trick No. 1: Learn the fundamentals.
Trick No. 2: Get it right in the camera.
But before he got to that, he answered
lots of questions, showed some beautiful

photos and made lots of other suggestions
for better pictures.
Holmes said he got his first camera —
probably a Brownie — as a child (7, 8 or
11, he said) and took pictures at Big Sur
of big waves breaking on rocks at midday (a time he now normally never
shoots, he said). “When I got the photos
back from the corner drug store, something happened. I looked at that and went,
ooh,” he said, and was hooked. In col-

lege, he asked his parents if he could borrow money to buy a Canon F1 from a
friend in Hong Kong, and they refused.
He got the camera for Christmas.
He retained his interest in photography and over the years made it his profession. “It became something I had to do,”
he said.
Holmes’ journey to becoming a professional began after a visiting friend told
(Continued on page 9)

More Q&A: Office versions, boot disks
(Continued from page 7)

is “restore an image.” If you do not click
on “restore an image” it will not destroy
any of your data.
Just to be clear, there are two different
kinds of disks to create. The first is the
Repair Disk on a CD, which will allow
you to fix minor problems with your
Windows. The second is a Restore Disk
set on several DVDs, which will allow
you to re-create your entire system setup
in the event the hard drive dies or becomes so severely damaged that recovery
is not possible.
Finding cheaper Office 2010
Q: On Office 2010 last time I checked
it was $500 for 2010 Pro. Where would
someone who is an average user buy the
program at less cost?
A: They are going to cost a lot even
with a discount. Our cost was around
$460. You can use the beta until Oct. 31,
2010, but it will nag you saying, “You are
not activated.” Using the beta is a way to
test the program; it will definitely shut off
Oct. 31 or Nov. 1, 2010, and you will not
be able to use it after that time. Office
2010 came out on June 17, 2010.
For most of the people in this room,
OpenOffice is a better choice than Microsoft Office even if they cost the same. It
is smaller, tighter, has more features you
can use in anything other than a corporate
setting and will read and write MS Office
documents. And it is free (it’s on the CIPCUG flash drive if you have it).
The only program to watch out for is

MS Access. If you have an Access database program, you’ll need MS Office Pro
at around $500.
Recovering from disks
Q: With the backup drive on the disks,
if my hard drive dies, what would be my
recovery process? What do I have to do
before?
A: When it was much harder to do
backups than it is today, when your hard
drive died, you cried a lot. In many cases,
it was cheaper to buy a new computer
than to repair the old. What you do now is
back up on DVDs, do a system repair
disk, which is a bootable repair disk on a
CD, and then say something dies on your
laptop. You go buy a new hard drive, flip
the laptop over, unscrew the hard drive
cover, take the old hard drive out, and put
in the new unformatted hard drive. Then
hit the power button, start with a boot
disk, it will ask if you want to restore,
you click Yes, and put in the DVDs one
at a time and in about 20 minutes, the
computer is exactly how it was when you
created the DVDs. If you have backed up
your data to flash drives, stick your flash
drive in the computer and restore your
data, and you are back in business.
You start the repair process with the
CD, and it creates a mini-operating system that will allow you to do things — to
fix your computer or if you have a new
hard drive and you want to restore, you
can tell it to restore and point it where
you have your restore image. What you
restore to depends on what you have. If

you burn the setup disk right after you
bought the computer and you restore from
those, your data will not be there, only the
set up from earlier on. If some of you
were using Carbonite or other online
backup storage, you would restore your
computer, then go to Carbonite, and restore all your data. If you are using a USB
drive and Windows 7 backup or something like that and you have created an
image, continuously update the image
with new data, and newly installed programs. If you have all your updates, etc.
stored on a USB drive you have all that is
needed should the computer crash. Carbonite does not restore everything, only
backup data, not programs.
Restrictions on new drive
Q: Are there any restrictions on the
new hard drive you put in — physically.
A: Yes. One of the options is if your
hard drive dies, you use this process, and
you are back to normal. If the hard drive
you have is too small and you go buy a
larger one, you do the exact same process.
The only restriction is that the hard
drive you put in to replace the old hard
drive must be the same size or bigger; it
cannot be smaller. And it must be the
same kind of drive architecture. You cannot put a Serial ATA (SATA) drive in a
Parallel ATA (PATA) computer. As a
general rule, if your laptop came with XP,
it is probably PATA. If Vista or 7, probably SATA. There are exceptions, so be
sure to check.
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Recommendations of Dan Holmes

The Rules of a Good Photo
Tell a story
Simplify
Get Close
Eliminate

Books
“Natural Light Photography,” by
Ansel Adams
“Mountain Light: In Search of the
Dynamic Landscape,” by Galen Rowell
“The DAM Book: Digital Asset
Management for Photographers,” by
Peter Krogh
“National Geographic Photography Field Guide: Secrets to Making
Great Pictures,” by Peter K. Burian
O’Reilly Books digital photography
guides

Software
Picasa, free basic editing
Adobe Light Room, a $300 program for advanced work
Camera
A digital single-lens reflex (DSLR)
(Nikon, Canon and Olympus are the
three top brands that should be
around for a long time)
A good tripod
Printers and ink
Canon and Epson, with HP a
close third
Epson papers and inks

More on Dan Holmes ...
(Continued from page 8)

him that “Galen had died.” “Galen” was
Galen Rowell, a student of Ansel Adams
and well-known photographer in his own
right. Holmes’ wife started buying some
of Rowell’s books for him, which served
as inspiration.
Holmes shoots many genres: landscapes, wildlife, portraits and weddings;
and teaches workshops. “Shooting is all
about light. It’s all about color, It’s all
about emotion” he said.
“The way I look at it is first there’s
the capture — seeing and grabbing the
image in the camera. The camera is the
hardware. The software is your vision.
“Then there’s the development; I’ve
called it the creation. Taking the photo
from the camera and using software to
finish the image. You can let the camera
do it … and guess what you’ve got.
You’ve got a picture that’s not going to
be much different than the millions of
other pictures that were taken with all
those other digital cameras.”
Adams would definitely work in the
digital darkroom, Holmes said. He spent
lots of time when making his prints burning and dodging to get the effects he
wanted — “he called the negative the
score and the print the symphony,”
Holmes said — and “what you see in his
pictures is not what you see with your
eye.”
Holmes asked the audience the difference between film and digital. One per-

son said digital is cheaper, but that’s not
the case, Holmes said; he buys a new
camera body every two or three years,
there’s software to buy, along with a good
monitor and printer and other equipment,
and most of all, your time is expensive.
“As far as the image goes, there’s no
difference” between digital and film, he
said, and he doesn’t shoot differently
when using one or the other. A sensor and
film are both substrates to capture light,
he said. “It’s a lot more about the image
than about the hardware,” he emphasized.
Although he still sometimes uses a
point-and-shoot camera to take pictures
of kids (it’s less intimidating than a big
camera), he recommends that people who
plan to be serious shooters graduate to a
DSLR – digital single lens reflex. The
point-and-shoot camera, he said, doesn’t
allow much opportunity to use depth of
field effects and other creative techniques.
Digital Single-lens Reflex cameras
(DSLRs) have two sizes of sensors, the
six-tenths and a full sized 35mm. The
six-tenths is cheaper and smaller than 35
mm. (It makes a telephoto lens longer,
but it takes away the wide angle, which,
for Holmes, is more important than telephoto.
Buyers of DSLRs should be careful
when buying lenses, he said. If you buy
lenses made for the 6/10th sensor, they
will not work with the larger sensor.
Holmes uses a tripod regularly

“because I’m shooting at the break of
dawn and the break of night” for landscapes with exposures are 8 to 30 seconds, he said. “The best way to save $700
on a tripod is to buy the right one the first
time,” he said.
Shoot with the highest quality settings
a camera has, he said, so you’ll have as
much data as possible to work with when
making prints.
Holmes sometimes shoots several
exposures of the same thing and uses layers in PhotoShop to do HDR blends. He’s
not a big fan of HDR software (high dynamic range imaging) yet, he said.
He was asked how to shoot a person
in front of a waterfall and get what you
want. “What made you stop? What one
thing made you grab that camera? Why
did you pick up the camera? Was it about
the person or was it about the waterfall?”
he replied. If you want to tell a story
about the person, get close and concentrate on him / her. If you want to tell the
story of the waterfall, move back and let
the person seem small.
Scenery can ruin a picture he said,
because “there’s so much stuff.” It is
important to look to the one thing you
want to emphasize in your picture and
eliminate the rest. It took him a while to
learn, he said, but when we look at something we concentrate on one thing, not an
entire scene. If you experiment with a
group of people — such as his audience
(Continued on page 10)

Page 10

The Outer Edge

June 2010

More on Dan Holmes ...
(Continued from page 9)

— you’ll see that if you look at one person, that person will be in focus, while
others will be out of focus. The focus
changes as you look at different individuals, he said. The same is true of whatever
you’re looking at.
A successful image has one point of
interest that makes it clear why you took
the picture, he said. There are emotional
reasons to take a picture — it’s cold, the
wind is blowing, the dog just bit the cat,
you just had a fight with your wife, and
so on — but the camera doesn’t pick up
any of those things, so you can’t convey
all those events and feelings in a snapshot, he said.
“We’ve spent a lifetime looking at
lousy images,” he said, “and that kind of
set the bar really, really low. I like to
make imagery that says, ‘Wow I would
have loved to have been there’ and it’s
kind of the feeling that I got when I was
there,” he said.
He was asked how he felt about taking a picture of the full moon in one location and a picture of a mountain peak in
another and composting the two. “I think
the compost word is just right,” he said.
That’s art rather than photography, he
said. He will adjust colors with software
to bring out the colors we see at a sunset
or sunrise, but won’t change the content
of the phot, he said.
To make a large print, get the best
picture you can by locking the camera
down on a tripod, Holmes said, because
the bigger you make a picture the more its
slightest flaws will show.
Adjusting the computer monitor is
important so what you see on the monitor
and the print will match, and it’s even
more important if you take your photos to
an outside lab for printing. Buying the
software to do that is another cost of digital photography, he noted.
Some things, including snow, lava
and a forest, are especially difficult to

Photo by Jerry Crocker

Speaker Dan Holmes, left, receives the microphone from Vice President
Craig Ladd.
shoot. There may be too much “stuff” and
it is difficult to find form and composition.
Concentrate on one point of interest,
he added, “If you’ve got a “plural” or
more than one point of interest, it’s not
going to be a good image.”
Asked why he uses a Macintosh, he
said he doesn’t want to worry about how
an operating system works. He just wants
to turn the computer on and have it work.
Most graphic artists use Macs, but PCs
work equally well, he said.
He said he uses cable shutter releases
and should use the mirror lock-up more
than he does.
Buy the very best CDs and DVDs you
can to store pictures, but remember that
everything degrades over time, he advised. Also label them so you can find
pictures on them. Don’t put a label on
them or print on them, he said. Use an
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(editor@cipcug.org), within the week after
Classified ads are free to members. the regular meeting. Otherwise, the ad is
Each ad is limited to 105 characters,
held to the following month.
including spaces and to one ad per
Wanted
member per month. Copy has to be to
Have a small flash drive that you don’t

Members’ classified ads

archival pen and write on the inner rim of
the CD or DVD. The best backup system
is one that is used. External hard drives
and some of the Iinternet backup programs are excellent.
Always carry extra batteries and
cards, he said.
Holmes said prints of his picture, several of which were displayed at the meeting, are $125. His calendars were sold for
$7. Orders can be placed on his website.
(The author expresses his appreciation to Dan Holmes for reviewing this
report for accuracy.)
On the Net:
http://www.danholmesphoto.com/
Danholmesphoto.com/Home.html
His
blog
is
at
http://
www.danholmesphoto.com/
Danholmesphoto.com/Blog/Blog.html
use? I could make good use of any 128
MB flash drives you care to donate for
next year’s volunteer income tax program.
— Art Lewis
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Highlights of Southwest Computer Conference
(Diane Mortensen and Craig Ladd
attended the Southwest Computer Conference as representatives of CIPCUG. Here
are their reports. — Editor)
By Diane Mortensen
appreciated the opportunity to represent CIPCUG at the Southwest
Computer Conference 2010. Last
year was my first time at the conference, and it was more familiar this time
around. Even though the format was the
same for 2009 and 2010 conferences, it
had some changes. Several items I liked
better this year than last were:
Vendors exhibits: On Saturday
night, attendees had more time this year
to speak to representatives from various
companies who were exhibiting. At the
end of the greet-and-meet, vendors were
introduced and gave a summary of their
product. All the vendors contributed door
prizes, and names were pulled after the
each vendor’s presentation.
At lunch on Saturday, there was a
Microsoft presentation, which, in my
opinion, was greatly improved over last
year. There were four representatives,
two older gentlemen and two younger.
Having been longer employed at Microsoft, the older representatives provided
“information.” The two younger representatives were more enthusiastic about
all the new products Microsoft was putting out. They were especially excited
about the new Microsoft retail stores
opening in California, Arizona, and Colorado. The first store opened in October
2009 in Scottsdale, Ariz. Approximately
a week later on Oct. 29, 2009, the Mission Viejo store in Orange County had its
grand opening. The San Diego store will
open soon and there is another planned
for Denver, Colo.
Craig and I rode to the conference
together and decided on the way back
home we would stop off and visit the
Microsoft Mission Viejo store. Before
leaving the conference, I downloaded off
the Microsoft website directions and a
map to the Mission Viejo store. We eventually found the store but not until after
driving around and around, stopping to
ask three or four people where the store

I

Photo from http://www.microsoftstore.com/missionviejo/

The is the Microsoft Store in Mission Viejo.
was located. They all said the map and
directions were totally wrong and redirected us to the main intersection, The
Shops. We were thinking a store located
in a minimall or similar to a Fed-XKinkos store, and that is what we kept
looking for.
We found The Shops street where the
store was supposed to be but could not
find the number. The store was located in
the Mission Viejo mall where I shopped
many times when I lived in Orange
County. No one said, “the store is in the
Mission Viejo Mall,” only that it is on
The Shops street, which I never heard of.
Once in the mall we found the store on
the upper level. It is a large, modern
store, well designed and for a Sunday,
there were quite a number of people trying out the equipment and products.
Both stores are poised to follow a
common formula partly based on Apple’s
retail shops that includes a theater for
concerts and learning sessions as well as
“answer bars.” Ironically, Apple also has
a store in the same Mission Viejo mall
where the Microsoft store opened.
For a Sunday, there were quite a few
people trying out and buying. We told the
rep who greeted us we had just come
from the computer conference, where
Microsoft reps had spoken highly about

the store. We also showed him the Bing
map and directions, and he could not believe a map could be so wrong. We were
impressed with the design of the store, the
quality of information the rep provided,
and the ability for customers to try out
various equipment before buying.
Microsoft has to date avoided making
any more definitive plans regarding future stores and is rumored to be taking a
wait-and-see approach to avoid overcommitting to retail without signs it will
be successful. The pressure is nonetheless
high on the company to expand as Apple’s retail revenue grew nine percent this
summer even in spite of an ongoing economic slump.
By Craig Ladd
t the Southwest Computer
Conference I attended seven
workshops. There were others
I would have liked to attend,
but they were conducted at the same time
as ones I attended. So I will do a quick
overview.
Insight Into Photography: Rick Edwards, associate of The Royal Photographic Society, official photographer,
Kenya Wildlife Service.
Rick covered many aspects of photography during his presentation, including

A

(Continued on page 12)
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showing a 15-minute slide show. Edwards is dedicated to developing the essentials that will help you add an extra
dimension to your photographs. One important point I took away was using Picturestoexe Deluxe 6.0 <http://
www.wnsoft.com/>, one of the best slide
show creators! If you go to theswcc.org,
you can get a zip file of slide presentations of photographs.
Organize Your Life with Evernote:
Jim Perry, Internet SIG Chair, Prescott
Computer Society.
With Evernote you can organize your
life by creating “notebooks” for different
categories. Anything that can be scanned
or copied, you can store on your PC or
laptop.
Evernote is a free product that makes
it easy to remember things from your life
using your computer, phone, and the
Web. Type notes, clip web pages, snap
photos, grab screen shots, and scan documents. Everything you capture is automatically indexed and put into notebooks
of your choice. Search for notes by keywords, titles, and tags. Get rid of your
paper files, and sync your Evernote information to all of your computers — PC
and Mac, and to your smart phone. Access your information from any Web
browser.

M

evernote.com, store any file, free 40
megabytes per month, 500 megabytes per
month for $45 per year.
Linux — Orv Beach: I introduced
Orv Beach and stayed for his presentation
on Ubuntu. He talked about open source
software and GNU license. Featured was
the Ubuntu operating system. There was
good attendance, and all of his discs with
Ubuntu were given out by the end of conference. I am trying out the Linux Mint
distribution of Ubuntu and so far like it !
Microsoft Tech session — David
Lynn & Woody Pewitt: Discussed were
Bing, Price Predictor for air fares, shopper, maps, and live sync. Another topic
was Windows Phone Office, Live Workspace. Office 2010, Mesh, Office Live
and Microsoft’s new Cloud offerings
were also discussed.
Social Networking — Cheryl
Wester, program chair, Temecula Valley Computer UG: The presentation was
described this way: “Facebook, Twitter?
Are these terms you have heard of but are
not really sure how to use or if you want
to. If so, this is the workshop for you.
Come learn about social networking and
have some fun. We’ll even set up an account for you. See you on Facebook! It’s
fun.” Two points covered the most were
privacy settings and chat.
What’s Cool, What’ Hot, and

What’s Not in Consumer Electronics
— Dave Whittle: Want to find the best
and avoid the worst gadgets, software,
and goodies? Dave, with help from
friends John C. Dvorak (PC Magazine),
Steve Bass (PC World), Robin Raskin
(Last Gadget Standing), Cheryl Currid
(ABC TV), Jim Louderback (Revision3),
and Chris Pirillo (CNN.com) share the
scoop on their best loved, most wanted,
and worst letdown consumer electronics
products, sites, and services.
Dave also showed how you can get
involved in the social revolution to easily
help your friends and loved ones in sharing recommendations and product experience, so everyone involved can get the
best and avoid the worst.
The session was interactive, lively,
and enjoyable. Dave did a show-and-tell,
featuring muvee Reveal 8, Windows software that takes your digital photos and/or
video clips and transforms them into a
DVD slideshow or music video. What’s
more, the CEO of muvee was there to
answer questions — direct from Singapore.
http://coolhotnot.com/ — referer whittle <lower case>, social sharing for trustworthy, unbiased tech product ratings.
The “Ins” and “Outs” of Digital Photography, Jim Glass, zip files available at
www.theswcc.org,workshops.

icrosoft has to date avoided making any more definitive plans regarding future stores and is rumored to be taking a wait-and-see
approach to avoid over-committing to retail without signs it will
be successful.
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Taking an SSD test drive: WOW!
By Rick Smith
rants@vcmail.net
hope everyone had a great Fourth
of July holiday this year. We live in
what I believe to be the greatest
country in the world, and I fly my
flag proudly outside my home. My sister
in Hawaii was lucky enough to buy a
home in Oahu that was previously owned
by a military man who erected a real flagpole in the backyard. You’ll
Rick’s
never find me “Striking the
rant
Colors.” God Bless The
USA! OK, now that I’ve
done my patriotic duty let’s
talk about computing. You
may have noticed that in
our monthly ad I’ve been
touting Intel’s “My SSD
Rocks” promotion. Well
Smith
today I’d like to explain
why I am such a fan of this
new technology and some of the terms
associated with it. I’ll try not to get too
technical, (I’ll leave that for those Linux

I

guys). But once you know the facts, you,
too, will become a fan of this new and
promising technology. Here are four reasons to consider an Intel SSD on your PC
or especially your notebook.
1. System Responsiveness. The performance bottleneck of modern PCs has
been the only main mechanical device, its
hard drive, for data storage. The new
SSDs, solid state drives, use nanotechnology instead of mechanical rotation of
metal data platters. The average total system performance increase is somewhere
from 43 percent to 57 percent. That’s
phenomenal! In one fell swoop you can
get that kind of performance increase. I’m
surprised the phone is not ringing already
with callers requesting this new product.
It’s what is known in the industry as a
“Game Changer.”
2. Ruggedness. Because of a lack of
moving parts these devices are far more
rugged that regular hard drives. This is
especially useful in notebook PCs. If you
dropped your notebook, it was always a

toss-up if your hard drive’s data would
survive the impact. Vibration can also
cause a drive to fail over time. Intel SSDs
have been tested up to 1,500 G’s. Now
maybe at the next meeting I can throw
one around and jump on it as a demonstration of what I’m talking about.
3. Power Consumption. SSDs have no
moving parts and subsequently use far
less power than a mechanical device. This
turns into greater battery benefits for your
notebook and makes you nice and green.
When the drive is in an idle or low power
state you can save up to 98 percent power
consumption compared to a regular drive.
4. Total Cost of Ownership. Even
though today’s solid state drives are more
expensive than a conventional hard drive,
if you take in all three previous factors,
greater productivity, reliability and lower
power consumed, an Intel SSD drive will
have a lower cost of ownership over time.
The more systems you own, especially in
business, the more this becomes evident.
(Continued on page 14)

Ventura County Computers (805) 289-3960
www.vccomputers.com

2175 Goodyear Ave. #117 Ventura 93003

My SSD Rocks!
Be the first on your block with this new technology.
Replace your boot device with an Intel SSD Drive.
Use your mechanical drives for data storage.
Watch you PC startup faster &
operate like never before.

VCC new PC SSD Upgrade
40GB X25X25-V Solid State Drive Upgrade $150.00
80GB Intel X25X25-M Solid State Drive Upgrade $250.00
160GB Intel X25X25-M Solid State Drive Upgrade $475.00
You know you want one. Don’t wait. Do your part to
stimulate the economy now! We’re waiting.

Page 14

The Outer Edge

June 2010

More on Rick’s rant ...
(Continued from page 13)

Now, you’ve probably noticed that I
only seem to mention Intel SSDs, not
other products. I believe that the Intel
MLC solid state drives are better than
their competition, and I’ll explain why.
But first let’s get up to speed on some of
the terminology involved in NAND flash
memory.
Lithography. Nanolithography refers
to the fabrication of nanometer-scale
structures, meaning patterns with at least
one lateral dimension between the size of
an individual atom and approximately
100 nm. Nanolithography is used during
the fabrication of leading-edge semiconductor integrated circuits (nanocircuitry)
or nanoelectromechanical systems
(NEMS). That is the Wikipedia definition. Here’s a more simple explanation:
Lithography is a measurement of how
thick the circuit lines are. So the smaller
Lithography, the more bits or data you
can cram into any given space. As you
get smaller and smaller, everything gets
more difficult as voltages and other factors become more pronounced. Intel partnered with Micron in manufacturing
about three years ago when the technology was at about 90 nanometers. It then

went down to 72; they then caught up to
the industry at 50 nanometers and then
led the industry at 34 nanometer technology and are now at 25 nanometer technology. And because the cost of NAND silicon is about 98 percent of the cost of producing the product Intel has a distinct
advantage at producing the best technology at the lowest cost.
Multilevel and Single-level Cell. Single level cell was the original design of
all flash memory. It was reliable and has
high endurance. The only thing that can
wear out a flash memory cell is how
many writes you write to it. You can read
indefinitely, you can have millions of
reads. But what wears a NAND out is
how many times you cycle the flash by
writing and erasing. Single cells deliver
more than 100,000 write cycles. A multicycle cell can hold two bits of data or
more and is more susceptible to write
cycling. Now you go down to 5,000 or
10,000 write cycles. This is why the
NAND controller technology is so important: It can tweak the memory-writing
process to get better cycling out of the
multilevel cell to minimize writes and
improve the life of the drive. There can
be anywhere from five to 85 flash chips

in an SSD device. This is where better
controller technology makes a big difference.
Write Amplification. Write amplification is a phenomenon where the host PC
wants to write one gigabyte of data to an
SSD device and poor controller technology will actually write up to 20 gigabytes
of information to get that one gigabyte of
data written. If you can lower your write
amplification to the drive it produces less
thrash, the quicker the drive works and
your endurance goes way up. Intel has the
lowest write amplification in the industry
at 1.1 — for every 1 gigabyte of information to be written only 1.1 gigabyte is
used. This allows Intel MLC SSDs to last
much longer than the competition.
So there it is. You are now all experts
on SSD NAND technology and can now
go out and bore everyone at the next
backyard barbecue. Or better yet hang out
at a Linux SIG where your newfound
knowledge is sure to be appreciated. Myself, I’ll be waiting right here by the
phone taking orders as America wises up
to the advantages of SSDs in their PCs.
P.S. Many thanks to Intel’s Troy
Winslow for providing me with the technical information.

Smart Computing tips and fun facts
Reprinted with permission from Smart
Computing.
Visit
http://
www.SmartComputing.com/Groups to
learn what Smart Computing can do for
you and your user group.
Improve your PC’s performance: If
you have a lot of data on your PC, adding
an external hard drive to your notebook
or desktop setup could help improve your
PC’s performance. You’ll be able to
avoid bogging your system down with
additional files. This will help save your
computer’s main hard drive from normal
wear and tear, thus helping it last longer.
HDTV shopping tip: Consider connectivity: Connectivity used to mean,
“Does a TV have enough of the ports
your A/V equipment uses?" Having
enough A/V ports, such as HDMI (High-

Definition Multimedia Interface) 1.3, is
still important, but today, you should also
look into an HDTV’s Internet connectivity features. Most Web-enabled TVs
can connect to your home network router
through an Ethernet cable, powerline
adapter, or wireless adapter (all sold separately). Once online, they can access content such as movie- and video-streaming
services, “widgets” that update you on
weather or sports scores, and a Web
browser for general surfing without a
computer. Also look for support for other
connections, as they make a TV even
more versatile. For example, many sets
can play video files and slideshows of
photos stored on USB devices and/or
memory cards.
Windows 7 shortcuts: Some of the

cooler Windows 7 windows management
tricks involve docking windows to the left
or right half of the screen. This feature
expands or contracts the current window
to half the Desktop and pins it to the edge
of your display. Press WIN (the Windows
logo key)-Left arrow or WIN-Right arrow
to dock the current window to the left or
right side of the screen, respectively. If
you continuously press WIN-Right arrow
or WIN-Left arrow, the current window
will cycle between its original size and
placement and being pinned to the left or
right half of the display.
To ensure CIPCUG receives credit
for new subscriptions and renewals,
always subscribe and renew using the
Subscribe or Renew Today! feature
(Continued on page 15)
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An open source PDF document creator
By Bill Wayson
bwayson@gmail.com
reating PDF documents may
not be an everyday task for
most computer users, but it is
for some. Perhaps you print up
notices for your club; invitations to a
party or shower; a sign notifying
neighbors of a lost pet; or brochures for a
nonprofit organization. Often, the final
product of these endeavPenguin’s
ors is a PDF document.
Lair
Now, you or your organization might part
with a few hundred dollars to purchase one of
the Adobe Acrobat products, the standard version of which will probably have everything you
need in a PDF document
production
application.
Wayson
Before you do, though,
you may want to consider a cost-free alternative that also supports most every
feature you might desire, an alternative
that has been around a while, is robust,
simple to use, and will run under Windows. This month we will survey the PDF
production features of OpenOffice.org, a
free office application suite.
Its PDF export functionality, and export functionality in general, has come a
long way since the earlier versions of
OpenOffice.org. Perhaps this explains
why the latest version of OpenOffice.org
Writer has both plain Export and Export
to PDF choices under the File menu, with

C

More Smart Computing ...
(Continued from page 14)

available within the User Group portion
of the Smart Computing Web site. From
here, select us from the drop-down list
provided to ensure we received credit for
the subscription order.
You can also call 800-733-3809 to
subscribe or renew and give us credit by
telling the representative you want us to
receive credit for the order.
Following these instructions will
ensure that we get as many free
subscriptions as we possibly can.

the Export menu offering PDF as one of
the export formats. Whichever choice you
make to export to PDF, the same options
dialog will be presented, and this dialog is
where you get many chances to tailor
exactly what you want in your exported
document. The dialog is divided into five
tabbed pages. The defaults will almost
always give you acceptable results. But
for finer control of your export, here are
some of your options.
The General tab controls basic features of the output. Here you choose
which pages to print: all, single pages, or
ranges. Ranges can even be noncontiguous parts of the source document. You
can control the final size of your PDF file
by changing the quality of embedded
images in your document. Keep in mind
that this is a tradeoff. The lower the quality, the less sharp the images will be. The
higher the quality, the larger the document, especially if there are a number of
images. If the best image quality possible
is required, then a lossless setting is available. The lower section in this tab contains several miscellaneous settings. You
can select PDF/A-1a output format,
which is the choice for documents meant
to be archived; Tagged PDF so that the
document produced can be opened by
certain document readers; create the output as a PDF form, which has fields the
recipient can enter information into, and
the format of the data they enter; whether
or not you want the export to include any
bookmarks, comments, or blank pages
that OpenOffice.org has created in the
document; and create a hybrid document
that includes an ODF-formatted version
of the document within the PDF file, allowing the PDF to be edited at a later
time.
The Initial View tab allows you to
choose what recipients will see upon
opening your PDF. Options are whether
or not to show bookmarks or thumbnails
along with the document, a specific initial
magnification, the page layout (single or
multiple pages), and which page to start
on (perhaps to skip over a title page or
table of contents). Of course, the reader
of your document will be able to change
to the view they prefer after they've

opened the PDF.
The User Interface tab provides additional control of the initial view of the
PDF, but here the options affect various
elements of the recipient’s PDF reader.
The reader can be resized to fit the initial
page, centered in the user’s screen,
opened in full screen mode, and be made
to display the document’s title. Next, you
can choose to hide the reader’s menu bar,
tool bar, and window controls, possibly at
the risk of annoying the recipient of your
PDF. The Use transition effects option is
specific to Powerpoint-like documents.
Saving such a document with transition
effects produces a PDF that can be
viewed as a slide show. The last option
allows you to limit the number of bookmark levels that appear in the reader program. In OpenOffice.org, bookmark levels are equivalent to header style levels.
The Links tab is useful if you are exporting a series of linked documents. If
so, then you’ll want to convert your bookmarks to named destinations (of links in
another PDF), convert your document
references to PDF targets (links to another PDF), and make the document links
relative to the filesystem (allowing the
links to work no matter where the group
of files is saved). Lastly you can allow
the links to open in the default mode of
the recipient’s PDF reader or force them
to be opened by a PDF reader or a Web
browser.
The last tab, Security, controls certain
security options of your PDF. Be aware
that the true security of a PDF document,
no matter how it is produced, is very low.
Software and instructions are easily found
and freely available on the Web that allow all PDF security controls to be circumvented. But if you wish to or must set
up security in your document, here you
set a password required to open the PDF
and another optional password that,
unless it is supplied, limits what the recipient can do with your opened PDF.
These limits include if the PDF can be
printed and, if so, at what resolution;
whether the PDF can be modified by, say,
inserting or deleting pages, or filling in
form fields; whether any part of the PDF
(Continued on page 16)
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Excel and Word tips
Excel: Indenting Cell
Contents
Microsoft Excel allows
you to format the contents
of a cell in myriad ways.
One of the formatting options you can apply is to
indent the contents of a cell
by a certain amount. This is
similar to indenting done in
a word processor, such as
Microsoft Word, except that
the indenting is specified in
a number of characters, not
in a linear distance such as
inches or points.
To set the indent to be
used in a cell, follow these
steps:
1. Select the cells you
want to format.
2. Display the Format
Cells dialog box. (In Excel
2007 display the Home tab
of the ribbon and click the
small icon at the lower-right
corner of the Number group.
In older versions of Excel
choose Cells from the Format menu.)
3. Make sure the Alignment tab is selected.
The Alignment tab of the Format Cells dialog box.
4. In the Horizontal
drop-down list, choose Left (Indent). If you are using Excel
6. Click on OK.
2002 or a later version, you can also choose Right (Indent).
© 2010 by Sharon Parq Associates, Inc. Reprinted by permis5. Using the Indent control, specify the number of charac- sion.Copyright
Thousands of free Microsoft Excel tips can be found online at http://
ters by which the cell contents should be indented from either excel.tips.net.
the left or right side of the cell. You can pick any whole number
(Continued on page 17)
between 0 and 15.

More on Penguin’s lair ...
(Continued from page 15)

can be copied and pasted; and whether
the PDF’s content can be used by accessibility tools, like a text-to-speech converter.
Even if you never use OpenOffice.org’s productivity applications, you
could still use it to open Microsoft Office
documents (it will even read the latest
Office 2007 file formats) from within

Windows and PDF them. Only the more
advanced creators of PDF documents will
miss anything. Everyone else will find
everything they need to produce a polished PDF document. And if you start to
explore the additional features of
OpenOffice.org, all the better.
If you have questions or would like to
learn more about Linux and FOSS, come
to the July Linux SIG meeting on the

fourth Tuesday, the 27th, at 6:30 p.m. at
Ventura County Computers in Ventura.
We will have a question-and-answer session this month, and will try to resolve
any problems brought forth. See the CIPCUG web site for more information. If
you have a question or topic you would
like the Lair or Linux SIG to cover, drop
me a line at bwayson@gmail.com.
Until next month, happy computing.
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More Excel and Word tips ...
(Continued from page 16)

Word: Inserting a
Non-Breaking Hyphen
When Microsoft Word
calculates line length and
wraps text to the next line,
it tries to wrap (or break)
the line at a space or a hyphen — a short dash.
Sometimes, however, you
may not want Word to
break a line at a dash. For
instance, dashes are used in
telephone numbers, and
you might not want a line
to break in the middle of a
telephone number.
The answer is to use
non-breaking hyphens instead of regular dashes
when you don't want Word
to break a line at the hyphen. To do this, hold
down the CTRL and
SHIFT keys as you type
the dash (this is the same
as typing CTRL and an
underscore). Word will The Special Characters tab of the Symbol dialog box.
then not break the line at
that point.
2. Click on the Special Characters tab.
You can also insert a non-breaking hyphen by following
3. Highlight the Nonbreaking Hyphen character.
these steps:
4. Click on Insert.
1. Choose Symbol from the Insert menu or, in Word 2007,
5. Close the dialog box by clicking on Cancel.
display the Insert tab of the ribbon, click Symbol in the Sym© 2010 by Sharon Parq Associates, Inc. Reprinted by permisbols group, and finally click More Symbols. This displays the sion.Copyright
Thousands of free Microsoft Word tips can be found online at http://
Insert Symbol dialog box.
word.tips.net.

    
Beware of messages purportedly from your bank, PayPal or other financial
sites asking for personal information, such as your login name, password or
Social Security number.
They are likely to be from scammers who hope to empty your bank account. If in doubt, go to the site of the institution by typing in a known URL,
not by clicking on the e-mail link, and look for messages there.
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Windows 7 and Carbonite: A personal horror story
By John Weigle
jweigle@vcnet.com
s a firm believer in the value
of backing up my computer
and as one who likes a bargain, I subscribed to Carbonite several months ago during its three
years for the price of one campaign.
I installed the program on my XP machine and had to leave the machine running 24/7 for several days for my initial
backup. That sounds like a long time, but
it’s not unusual because Carbonite is
copying all the information you want to
back up to its online servers.
Carbonite receives high praise from
Jeff Levy, Kim Komando and Leo LaPorte, so I felt confident that, with a fast
enough Internet connection, I should not
have any problems. And it meets one of
the principles for good backups: having
one offsite in case your computer is stolen or destroyed by fire or other disaster.
After the initial backup, Carbonite
chugged along as expected, backing up
new or changed files when my computer
was idle or when I told it to back up immediately.
I was a satisfied customer, ready to
recommend the product to anyone who
might ask. I had seen some of the complaints at various online forums, but
every program has people who don’t like
it, so those didn’t bother me.
Then I switched to Windows 7.
I have Windows and my programs on
a solid state drive and my documents on a
my old C: drive (not solid state). I reinstalled Carbonite, and it seemed to be
working fine.
I turned off my computer for the night
and when I got up the next morning and
rebooted it, I noticed the Carbonite icon
was not on the task bar, meaning it had
not started automatically. I started it,
clicked on the Status link on the menu —
and got the error message shown in column 2.
I tried the obvious: temporarily turning off the firewall and Norton AntiVirus, hoping they weren’t the problem
because I don’t like the idea of not having
those programs running.
Carbonite still didn’t work.
Over a period of several days, I spent

A

time exchanging e-mails and on chat with
Carbonite tech support, which advised me
to:
— Turn off the firewall.
— Turn off the anti-virus.
— Eliminate the local hosts file except for a Carbonite listing.
— Allow the Carbonite programs in
the firewall.
— Turn off Windows Defender
(which, according to Windows, wasn’t
turned on).
None of those worked.
A tech support person took over my
computer, did all the same things again
and looked for other programs that might
conflict with Carbonite. She found nothing.
I was told that the problem had been
kicked up to the next level of support
several weeks ago, but have had no response since then.
I posted a question in the Windows
Secret Lounge, and no one had an answer, although several people had suffered a variety of problems, none the
same as mine. One of the recommendations, of course, was to turn off Norton.
Been there, done that, thank you.
Another writer said he is using idrive
(http://www.idrive.com) with no problems. I might give that a try.

If I reinstall Carbonite, it works fine
— until the next reboot, at which point
the problem reappears.
Obviously, having to reinstall a program every time I want to use it is not a
satisfactory solution — and it certainly
doesn’t inspire great confidence that I
would be able to restore my files if I ever
had to.
I like the idea of an offsite backup if it
doesn’t cost me a small fortune, so I’d
like to make Carbonite, or a similar program, work, but I don’t know what to do.
My current guess is that there’s something about Windows 7 that Carbonite
doesn’t like or something about Carbonite
that Windows 7 doesn’t like, but that
doesn’t help me much.
I’m considering buying another external drive, backing up to that, and keeping
it in my car since I’ll be retiring from The
Star in the next few months (still no date
on when our big changes occur) and
won’t be able to keep the drive at work.
Is anyone in the club using Carbonite
successfully on Windows 7? If so, did
you have to do something special to make
it work or did it just do what it’s supposed to after being installed? Did anyone
else try to make it work and fail? Either
way, I’d like to hear your story. Maybe
it’ll help find a solution.
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Computing 101: Some tips for beginners
By John Weigle
jweigle@vcnet.com
The importance of passwords
No one likes to think about this, but
what happens to the information on your
computer if you die or are incapacitated?
Will your spouse, executor or other
family members be able to sign on to
your computer or into your account?
Will they have access to your banking
information?
Can they get to your e-mail?
Your Facebook (or My Space or
whatever) page?
Your Excel financial information?
Your eBay or Amazon accounts?
Or any of the dozens of other files or
accounts that are important to you and
could be essential to whoever is handling
your affairs or your estate for you?
For that matter, what if you forget an
essential password and can’t unlock a file
you made secure that contains information you need right now.
What if you use some kind of password storage program and the password
to that just won’t come to you?
You need a backup of your passwords
in some form that isn’t locked up in your
computer.
It could be a printout of a spreadsheet,
a handwritten list in a binder (or hand
printed list if your writing is as bad as
mine) or even a box of 3x5 cards with the
account or file name and password, along
with the answers to any security questions
that you have to answer if your forget
your password.
If you don’t want to keep such a list at
home, put it in your safe deposit box or
file it with your attorney, but have one
somewhere.
Naturally, you don’t want to spread
the list around to just anyone, but there
must be someone you trust enough to
give them the information or at least a
notice that such a list exists in your safe
deposit box.
None of us will live forever, so plan
ahead for the person who has to handle
your affairs.
After all, you have a will, don’t you?
Scanners and Windows 7 / Vista
If you skipped the upgrade to Vista

but plan to go to Windows 7, as I did, you
need to know that you’ll probably have to
replace your scanner.
Scanners that worked fine in XP don’t
work in Vista or 7, and manufacturers
aren’t writing drivers that would let them
work.
Just figure that it’s another expense of
moving to a new operating system.
Cutting down on programs
If you upgrade to Windows 7 or whatever comes after it, it’s a good time to
look at all the programs you had on the
old operating system and see if you really
want to reinstall them. (Rick will be surprised to hear me say this.)
If you weren’t using them in the old
operating system, you probably won’t use
them in the new one, so don’t bother to
reinstall them. Doing so just takes time
and clutters your hard drive.
You might also learn that the new
operating system now includes features
that you used to need additional software
for. Windows 7 has software to burn CDs
and DVDs so you might not need that
program you bought to do the task a few
years ago.
Free software
There might not be any such thing as
a free lunch, but there is such a thing as
perfectly good free software.
Those of you who attend meetings
have heard Toby and Michael recommend any number of free programs, and
CIPCUG has even offered CDs and flash
drives with programs that the two of them
recommend.
And regular readers of the Penguin’s
Lair know that Bill Wayson has recommended lots of open source software,
including various versions of Linux, a
free operating system and the popular
OpenOffice, which is eating into Microsoft’s profits on its Office programs.
Exercise due diligence, however, and
don’t just download every free program
you hear about. As we’ve been warned
several times during meetings and in
other forums, lots of the purported free
anti-spyware programs are really the spyware and other malicious programs
you’re trying to prevent or remove.
Use trusted sources like CNET.com or

SourceForge.net to search for the programs you need rather than going to some
site like “softwares” or “softwarez” and
hoping for the best.
Dire warnings
If you get e-mail long enough, sooner
or later you’ll get a message that delivers
some dire warning about a new virus
along with a message to “send this to
everyone in your address book.” Before
you panic and do that, spend a few minutes on the Web to do some checking
because there are lots of hoaxes out there.
Visit, for instance:
— Snopes.com, which tracks all kinds
of rumors about everything from autos to
weddings. Most of the worst stories you
hear turn out to have no basis in fact.
— http://urbanlegends.about.com.
— http://www.scambusters.org/
legends.html
While you’re at any of those sites,
enjoy the stories that others have fallen
for — but remember that we’re all subject
to being suckered.
Using built-in help
Lots of programs no longer come with
manuals, and after-market books are usually expensive. What is one to do?
For a start, press the F1 key or go the
Help menu of the program you’re interested in, and you’ll probably find an
online manual.
If neither of those works, use your
favorite search engine to seek a solution
on the Web or visit the manufacturer’s
Web site for FAQs (frequently asked
questions), a downloadable manual or
other help.
And there’s always the F1 column in
every issue of The Outer Edge.
Serial numbers
Most commercial software today requires a serial number to install (or reinstall).
The number is usually on the package
the software is shipped in or the CD container. If you’ve downloaded the program, the serial number should come in
an e-mail. Keep those numbers where you
can find them because you’re going to
have to reinstall the program sometime,
and without the number you’re in big
trouble.
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about this and that

T

his issue is a little later than I would like, but I ran
into some time problems and the Fourth of July
holiday. Fortunately, United Parcel has several
shipping methods to choose from, so we can pay a
little more to our printer for faster shipping. You should have
this issue in plenty of time before the July meeting.
Once again, I went to 24 pages, something I tried hard to
avoid when we had to hand-fold TOE in the home of George
and Arline Lakes. Getting a 24-page issue thin enough to fit
through the Postal Service’s template was a real problem. Now
that we’re mailing flat, the number of pages
Editor’s
isn’t nearly the issue it used to be.
corner
***
We’re all happy to see Helen Long up and
around again and well enough to resume her
work on cipcug.org. Thankfully, the change in
the photos section simplified the problem that
most frustrated her, so we’re now seeing regular updates on the page (the missing issues of
TOE were up soon after she took the job
again).
Weigle
As Toby and others have mentioned at many
meetings, we’re a volunteer organization and can always use
more help. If you’d like to work on a project, help Craig Ladd
find programs (or give one yourself), or just help set up chairs
before the meeting, there’s always room for more. Come and
be a member of the insiders’ clique. You won’t even have to
learn a secret handshake.
***
There’s no Jeff Levy column this issue because I haven’t
gotten permission from his producer, who now lives out of
state, to use the lesson I picked. With luck, he’ll be back in the
next issue.
Jeff is now on KABC Talk Radio (790 on the AM dial),
but his time slot is sometimes moved because of sports events.
His July 10 show was from 5 to 6 p.m., but I’m not clear on
whether that’s a new time or a sports-adjusted time. The
KABC web site lists both the 5-6 p.m. and the 3-4 p.m. slots
for the show. If you’re near a radio on Saturdays, check both
to be sure.
***
There’s a slight change in this issue that you might or
might not have noticed: Each page has more type on it. Microsoft Publisher used to put up pages with one border representing the outermost boundary for type and another box inside
that I assumed was the preferred location for text boxes. That
box doesn’t show up any more, so I’ve gone to the outside
borders on all the pages, which, as the number of pages grows,
adds a lot of characters. It required a lot of rejuggling this
time, so enjoy.
— John Weigle, editor
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Treasurer’s
report for
May 2010
By Art Lewis
treasurer@cipcug.org
5-1-2010 through
5-31-2010
Category Description
INFLOWS
Coffee income
Donation
Membership Income
New members
Renewals
TOTAL MEMBERSHIP
Raffle
TOTAL INFLOWS
OUTFLOWS
Corporate Exp.
ISP Expense
Rent Paid
TOE
TOTAL OUTFLOWS

Lewis

-17.50
2.00
40.00
425.00
465.00
78.23
527.73

475.00
255.00
150.00
214.69
1,094.69

OVERALL TOTAL

-566.96

Bank Balance 5-3-10

7,362.23

2010 contributors to The Outer Edge
Helen Long
Your name can appear
here, too. Share your
Diane Mortensen
Sharon Parq Associates
knowledge with other
members by sending an Inc.
article, letter or computer tip
Toby Scott
to editor@cipcug.org.
Michael Shalkey
Phil Sorrentino (APCUG)
Ken Church
Rick Smith
Jerry Crocker
Rick Curry
Smart
Computing
Bob de Violini
magazine
Bill Wayson
Jeff Levy
Art Lewis
John Weigle
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Membership report:

Is it time to renew?

Mbr# Last Name

First
Name

Pd to Dt

By Ken Church

0878

Garner

Bill

201006

email address: membership@cipcug.org

1221

Harris

Jack

201006

0148

Leventhal

Bob

201006

0469

Magallanes

CB

201006

0342

Page

John

201006

Welcome New Members: Needed

CHURCH

Attendance at the June 2010 general meeting:
67 members and guests
Total membership: 210

July 2010 renewals payment due:
Last Name

First
Name

Pd to Dt

1028

Burke

Jim

201007

MEMBER RENEWAL INFORMATION
$30 for single membership,
$35 for two or more family membership.

Mbr#
0350

Colter

Don

201007

NEW MEMBER INFORMATION
$40 first year for single membership,
$55 first year for two or more family membership in same household.

0354

Ferro

Joe

201007

1229

Kirschke

Randy

201007

0624

Lambert

Ted

201007

1149

Little

Robert

201007

0331

Livingstone

Robert

201007

1144

Mortensen

Diane

201007

0873

Pass

Jim

201007

1157

Sifuentes

Octavio

201007

0358

Tanner

Henry

201007

0020

Van Slyke

Kathy

201007

0019

Van Slyke

Noel

201007

0977

Westefer

Paul

201007

0601

Wymore

Bob

201007

Please send your payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the sign-in table for
the July 24, 2010, meeting.
May 2010 renewals payment due:
Mbr# Last Name

First
Name

Pd to Dt

0584

Bircher

Andrea

201005

0340

Burger

Lou

201005

0774

Hoffman

LaVern

201005

1175

Makuch

Michael

201005

1175
A

Makuch

Suzanne

201005

1204

Michrina

Andy

201005

June 2010 renewals payment due:
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Initials
BDV

Name
Bob de Violini

(805)
rjddev@gmail.com

BR

Bill Robinson

389-2997 (b)
bill@bzus.com

DM

David Minkin

469-6970 (cell);
484-2974 (home);
dddave@cipcug.org

MS

Michael Shalkey mshalkey@cipcug.org

RP

Robert Provart

498-8477 (b)

Phone: (d) = days; (e) = evenings; (b) = both

F1—Your Help Key
(Revised Sept. 7, 2008)
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM
DATABASES
Access

BR

DOS

RP

E-MAIL
Outlook
Outlook Express
Thunderbird

MS
BR, DM
MS

GRAHICS PROGRAMS
IrfanView
Paint Shop Pro
Photo Shop Elements
Print Shop

MS
DM
BR
BR

SPREADSHEETS
Microsoft Excel

DM

WORD PROCESSING
Microsoft Word
WordPerfect

DM
DM

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM, MS (98)
BDV
DM

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.
........................
WEB HELP SITES
Annoyances Central blog (from authors of the O’Reilly
An n o ya n c e s s e r i e s , i n c l u d i n g S t e v e B a s s ) :
www.annoyancescentral.com/
Steve Bass TechBite Newsletter: www.techbite.com/
DSL reports: www.dslreports.com
Steve Gibson: www.grc.com/
Kim Komando: www.komando.com
Leo Laporte: www.leoville.com/
Jeff Levy: www.jefflevy.com
Linux distributions: www.DistroWatch.com
Microsoft: www.microsoft.com/
Microsoft Windows XP The Official Magazine (UK):
www.windowsxpmagazine.co.uk/
Microsoft Windows Vista The Official Magazine (UK): /
www.windowsvistamagazine.com/US/
Online safety tips: www.OnGuardOnline.gov
PC Pitstop: www.pcpitstop.com/
PC World: www.pcworld.com/
Recalled products: www.recalls.gov
SANS Institute — Computer Security Education and
Information Security Training: www.sans.org/
Smart Computing: www.smartcomputing.com/
Spyware Warrior: www.spywarewarrior.com/
User Group Relations (Gene Barlow): www.ugr.com/
Ventura County Computers (Rick and Toby’s shop):
www.vccomputers.com
Virus Bulletin: www.virus-bulletin.com/
Windows Secrets: ww.windowssecrets.com/
ZD Net spyware blog: www.blogs.zdnet.com/Spyware
If you have a favorite help site on the Web, please forward
it, so we can expand the section. If you find a link that
doesn’t work, please tell us that, too.

June 2010
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Why join Channel Islands PC Users
Group (CIPCUG)?
Every month, members of the Channel
Islands PC Users Group have access to:
♦ The Outer Edge newsletter, which
includes a list of members willing to help
other members.
♦ The general meeting, featuring a
question-and-answer session and program
on new software or hardware.
♦ Special Interest Groups — special
meetings held several times a month.
♦ Door prizes at the regular meeting.
Other benefits include:
♦ Special user group discounts on
books and software.
♦ An Internet service provider at a
large discount (see next column).
♦ A flash drive containing many

useful freeware programs.
address), $55.
Renewals are $30 and $35 per
♦ A chance to make friends with
year respectively.
people who have similar interests.
♦ The ability to put your knowledge
CIPCUG E-MAIL ADDRESS
to good use by helping other members.
Members
who would like to have an
The whole concept of user groups is
e-mail address through CIPCUG in the
members helping members.
form of YourName@cipcug.org may obtain one for $15 per year.
Please clip the coupon below and
send with payment to CIPCUGCIPCUG INTERNET SERVICE
Membership, P.O. Box 51354, Oxnard,
TECH TEAM
CA 93031-1354.
David Minkin, 469-6970 (cell), 484Please make checks payable to
2974 (home)
CIPCUG.
dddave@cipcug.org
Bob Thompson, 647-2287
Dues for new members
Individual member, $40.
Family membership (same

CIPCUG MEMBERSHIP
APPLICATION

Can you help the club as a volunteer? If so, what would you
be interested in working on?

Amount enclosed: ____________________________
Please Print the following information:
Name: _______________________________________

Address: ______________________________________

City: ___________________________, State:________
Date __________________ Member # ____________
ZIP Code: _______________________________

Phone (Home): ______________(Work): ______________
E-mail address: ________________________________
User level: Novice ____; Intermediate _____; Advanced
_____

The Outer Edge
Channel Islands PC Users
Group Inc.
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P.O.Box 51354
Oxnard, CA: 93031

NON-PROFIT
June 2010
U.S. POSTAGE
PAID
OXNARD. CA
PERMIT NO. 1785
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DUES REMINDER
If the number above your
name is 201007, your
membership dues are
payable in July 2010.

July 2010 meeting
Of the Channel Islands PC Users Group
The map shows
the easiest route
to the Boys &
Girls Club, but if
you prefer, you
can take the
Carmen Drive
offramp to
Ponderosa Drive,
which leads to
Temple Avenue.

Saturday morning, July 24, at the
Boys & Girls Club, Ponderosa Drive
and Temple Avenue, Camarillo, Calif.
Meeting Schedule:
8:30 a.m.
Doors open
8:45-9:30
Internet and networking SIG,
Computing 101 SIG
9:30-10:30
Business meeting, Q&A
10:30-11:00
Break — Please contribute
requested amounts for coffee
and doughnuts
11:00-12:00
Program (Infogrip)
Drawing
1:30
After-meeting SIG by Michael
Shalkey

